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SciELO PC Programs is a set of tools of SciELO Methodology. They run on Windows and are used to manage
journals, issues and articles data, in order to prepare them to the data processing which generates the website (SciELO
Site).

Contents 1
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2 Contents



CHAPTER 1

Download

Download by FTP

• server: ftp.scielo.br

• user: produtos-scielo

• password: produtos@scielo

3

mailto:produtos@scielo


pcprograms Documentation, Release 4.0.050

4 Chapter 1. Download



CHAPTER 2

Requirements

• JAVA

• PYTHON 2.7.x
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CHAPTER 3

How to install

1. Download the last version

2. Run the program

3. Follow the instructions given in each screen

4. Configure

application’s name Examples: SciELO Brazil, SciELO Chile, SciELO v4.0, etc., or just SciELO.

URL production website address Example: www.scielo.br

destination data folder folder which have serial folder
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5. Select the programs you want to install in your computer, considering if it is the local server or the markup
computer.

3.1 Programs for local server

• Code Manager: program to manager tables of codes/labels. For example, countries table: BR (code) and Brazil
(label)

• Title Manager: program to manager journal data that are part of the collection, their issues and sections of table
of contents

• Converter: program responsible for loading the CDS / ISIS databaseusing complete text documents previously
marked

• Markup: program to identify each bibliographic element on articles and texts

• SGML Parser: program to identify possible markup errors on the marked files. It is always installed.

• XML SciELO: program (optional) to create XML format accepted byPubMed and ISI

3.2 Programs for Markup Computer

• Markup: program to identify each bibliographic element on articles and texts

• SGML Parser: program to identify possible markup errors on the marked files. It is always installed.

Note: Markup - automata files are examples of automatas. Its installation is optional.

8 Chapter 3. How to install
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6. For local server installation, set the environment variable BAP as OS23470a.

7. By Windows menu go to: Control Panel -> Performance and Maintenance -> System -> Advanced Settings ->
Environment variables.

8. Check if the variable already exists.

9. If it does not, click New and enter the data.

10. Install Java and set its location in PATH.

11. The shortcurts are created to administrator user, so copy the shortcuts for all the users.

12. Give the write permission to non-admin users on C: (for Parser usage) and all the folders below the bin folder,
because the programs generate files in these folders.

13. Select the C: drive and click on Properties option.

3.2. Programs for Markup Computer 9
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14. Open the security tab

10 Chapter 3. How to install
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15. Select users (common users)

3.2. Programs for Markup Computer 11
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16. Click on Edit button

12 Chapter 3. How to install
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17. Check all the permissions. Then click on Apply to set the permissions.

3.2. Programs for Markup Computer 13
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CHAPTER 4

Concepts of the SciELO Methodology

• Local server

• SciELO collection or instance

• Types of issues

• Sequential number

• Folders structure

• Programs folder

• Data folder

4.1 Local server

It’s a Windows machine where the PC Programs and SciELO website (local site) run.

4.2 SciELO collection or instance

SciELO Collection or instance is a website generated using SciELO Methodology, including the ones which do not
use SciELO in their website name.

Examples of collections or instances: SciELO Brazil, SciELO Chile, SciELO Salud Pública, Rev@Enf, etc.

4.3 Types of issues

regular or supplement number formed by articles and texts

ahead manuscripts that were approved by editorial board but they are not in a definitive issue. There is an ahead
number by year.

15
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review/provisional number whose purpose is to group accepted articles which are still under review, leaving only
their metadata published. There is a review number by year. Note: at the site the name adopted is provisional

pr (press release) number whose purpose is to group the press releases texts of a number or article. There is a pr
number by issue.

4.4 Sequential number

The sequential number is a number formed by year (YYYY), followed by a number that gives the issue’s order within
a year.

This number has two purposes:

• order of the issue within a year in the “all issues” page of the website

• forming PID. It is strongly recommendable DO NOT MODIFY THIS ITEM if the issue has already been
published on the website.

By convention, the sequential number is:

• ahead = 50

• review/provisional = 75

• pr = from 100

Example:

v.40 n.1 20091
v.40 n.2 20092
v.40 suppl. 20093
v.40 suppl.2 20094
v.40 n.2 suppl.1 20095
ahead 200950
review 200975
v.40 n.1 pr 2009100

4.5 Folders Structure

SciELO PC Programs package has the folders:

• bin and xml_scielo, for programs

• serial, for data

You can install them in the same or different folders. BUT by CONVENTION, we recommend C:\scielo\bin and
c:\scielo\serial.

Examples of the same folder:

• c:\scielo\bin. . . and c:\scielo\serial

• d:\scielo_v4.0\bin and d:\scielo_v4.0\serial

Examples of different folders:

• c:\scielo\bin. . . e d:\scieloserial

• d:\scielo-programs\bin. . . and d:\scielo-dataserial

16 Chapter 4. Concepts of the SciELO Methodology
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4.6 Programs folder

It contains the programs. E.g.: \scielo\bin

4.7 Data folder

e.g.: \scielo\serial

In this folder are all data, all the databases.

• title: it contains data records related to the journal

• section: it contains data records of sections of the table of contents

• issue: it contains the records of journal’s issues

• code: it contains tables of codes/labels

• PubMed: is used in order to archive the XML files sent to PubMed

• ISI: is used in order to archive the XML files sent to ISI

• several Journal’s folder: which contains the issues of the journal

4.7.1 Journal’s folder

e.g.: \scielo\serial\<acronym>

It contains several folders, each one for each issue of the journal.

4.6. Programs folder 17
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4.7.2 Issue folder

It contains folders like:

• markup: articles and text files, with markup

• body: articles and text files, original, no markup

• pdf: articles and texts in PDF format

• img: image files extracted from the PDF files

• base: the databases generated by Converter from the files of markup and body folders.

There are rules to name theses folders:

• Folders for regular numbers and supplements: v, followed by the volume number, s, followed by the supplement to volume, n, followed by the number issue, s, followed by the supplement number

Examples:

– v31n1 (volume 31, number 1)

– v31n1s1 (volume 31, number 1, supplement 1)

– v31n1s0 (volume 31, number 1, supplement)

– v31s0 (volume 31, supplement)

– v31s1 (volume 31, supplement 1)

– v31nspe (volume 31, special number)

– v31n3a (volume 31, number 3A)

• Review / Provisional’s and ahead’s folder: publication’s year, n, followed by the word review or ahead

Examples:

– 2009nahead

– 2010nreview

• Ex-review/provisional’s and ex-ahead’s folders: ex-, followed by publication’s year, n followed by the number. NOTE: Converter creates these folders, because it is only way to control data files which were review/provisional and/or ahead once.

Examples:

18 Chapter 4. Concepts of the SciELO Methodology
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– ex-2009nahead

– ex-2010nreview

• Press releases’ folders: it follows the same rules of regular numbers and supplements, review / provisional and ahead, adding pr at the end of the file name.

Examples:

– v31n1pr (press release of volume 31, number 1)

– v31n1s1pr (press release of volume 31, number 1, supplement 1)

– v31n1s0pr (press release of volume 31, number 1, supplement)

– v31s0pr (press release of volume 31, supplement)

– v31s1pr (press release of volume 31, supplement 1)

– v31nspepr (press release of volume 31, special number)

– v31n3apr (press release of volume 31, number 3A)

4.7. Data folder 19
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CHAPTER 5

Local website

SciELO Website for Windows.

21
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CHAPTER 6

Programs for local server

6.1 Code Manager

• single-user program,

• Visual Basic

• used on local server

• manage the tables of codes and values used by all the programs of SciELO Methodology.

There are tables which contents are rarely changed, for example, languages. There are tables where the content is
customizable for each collection. Currently: sponsor, markup center.

The table of subject areas was customizable. But now, it is required all the collections of the SciELO Network use the
same table.

This program is only used if it is necessary to change data of the customizable tables.

6.1.1 Opening the program

To open the program, use the Windows menu, select SciELO, then Code Manager

23
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6.1.2 Managing the tables

1. Select Files

• Restricted Area is used only by the developers of SciELO methodology. It is password protected.

• Customizing Tables is to manage the customizable tables.

24 Chapter 6. Programs for local server
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6.1.3 Accessing a table

Select one of the tables, clicking the button . . .

The data of the tables will be presented in the format: code | label in Portuguese | Spanish | English.

6.1. Code Manager 25
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6.1.4 Removing a row of the table

1. Select a row to delete. Its data will be presented at code and labels fields of each language.

2. Click on Remove button.

3. Click on Save button

6.1.5 Updating a row of the table

1. Select a row to update. Its data will be presented at code and labels fields of each language.

2. Click on Update button.

3. Click on Save button

26 Chapter 6. Programs for local server
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6.1.6 Creating a new row

1. Fill in the fields: code and label of each language

6.1. Code Manager 27
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6.1.7 Technical information

Code database

ISIS database. One record by table.

Field 1 Subfield *: table name Subfield l, optional: language

Field 2 Subfield c: code Subfield v: value

NewCode database

Same structure of code database, but the records corresponding to the editable tables are the only records that would
be different.

Code database Content

28 Chapter 6. Programs for local server
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doctopic

code value
ab abstracts
ax annex
an announcements
sc brief communication
co comments
cr case report
ct clinical trial
ed editorial
in interview
le letter
mt methodology
oa original article
pv point-of-view
pr press release
rc recount
rn research note
ra review article
tr technical report
up update

role

code value
nd Not defined
coord coordinator
ed publisher
org organizer
tr translator

standard

code value
iso690 iso 690/87 - international standard organization
nbr6023 nbr 6023/89 - associação nacional de normas técnicas
other other standard
vancouv the vancouver group - uniform requirements for manuscripts submitted to biomedical journals
apa American Psychological Association

6.1. Code Manager 29
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ccode

code value
bjce brazilian journal of chemical engineering
bjg brazilian journal of genetics
bjmbr brazilian journal of medical and biological research
bjp brazilian journal of physics
conicyt Comisión Nacional de Investigación Científica y Tecnológica
dados dados - revista de ciências sociais
br1.1 scielo/bireme
infomed InfoMed
jbchs journal of the brazilian chemical society
jbcos journal of the brazilian computer society
mioc memórias do instituto oswaldo cruz
rbcs revista brasileira de ciência do solo
rbgeo revista brasileira de geociências
rimtsp revista do instituto de medicina tropical de são paulo
rsp revista de saúde pública

literature type

code value
C Conference
M Monograph
MC Conference papers as Monograph
MP Project papers as Monograph
MPC Project and Conference papers as monograph
MS Monograph Series
MSC Conference papers as Monograph Series
MSP Project papers as Monograph Series
N Document in a non conventional form
NC Conference papers in a non conventional form
NP Project papers in a non conventional form
P Project
S Serial
SC Conference papers as Periodical Series
SCP Conference and Project papers as periodical series
SP Project papers as Periodical Series
T Thesis and Dissertation
TS Thesis Series

30 Chapter 6. Programs for local server
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treatment level

code value
am analytical of a monograph
amc analytical of a monograph in a collection
ams analytical of a monograph in a serial
as analytical of a serial
c collective level
m monographic level
mc monographic in a collection
ms monographic series level

status

code value
? Unknown
C Current
D Ceased
R Reports only
S Suspended

month

code value
1 Jan.
2 Feb.
3 Mar.
4 Apr.
5 May
6 June
7 July
8 Aug.
9 Sept.
10 Oct.
11 Nov.
12 Dec.

6.1. Code Manager 31
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date

code value
Jan. January
Feb. February
Mar. March
Apr. April
May May
Jun. June
July July
Aug. August
Sept. September
Oct. October
Nov. November
Dec. December

country

code value
AF Afghanistan
AL Albania
DZ Algeria
AS American Samoa
AD Andorra
AO Angola
AQ Antarctica
AG Antigua
AR Argentina
AU Australia
AT Austria
BS Bahamas
BH Bahrain
BD Bangladesh
BB Barbados
BE Belgium
BZ Belize
BM Bermuda
BT Bhutan
BO Bolivia
BW Botswana
BV Bouvet Island
BR Brazil
VG British Virgin Islands
BN Brunei
BG Bulgaria
BU Burma
BI Burundi
BY Byelorussian RSS
CM Cameroon

Continued on next page
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Table 1 – continued from previous page
CA Canada
CV Cape Verde
CF Central African Rep.
TD Chad
CL Chile
CN China
CO Colombia
CG Congo
CR Costa Rica
CU Cuba
CY Cyprus
CS Czechoslovakia
DK Denmark
DM Dominica
DO Dominican Republic
NQ Dronning Maud Land
EC Ecuador
EG Egypt
SV El Salvador
ET Ethiopia
FK Falkland Islands(Malvinas)
FJ Fiji
FI Filand
FR France
GF French Guiana
PF French Polynesia
GA Gabon
DD German Democratic Republic
DE Germany, Federal Republic
GH Ghana
GI Gibraltar
GR Greece
GL Greenland
GD Grenada
GP Guadeloupe
GU Guam
GT Guatemala
GC Guinea Ecuatorial
GN Guinea
GW Guinea-Bissau
GY Guyana
HT Haiti
HN Honduras
HK Hong Kong
HU Hungary
IS Iceland
IN India
ID Indonesia
IR Iran
IQ Iraq

Continued on next page
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Table 1 – continued from previous page
IE Ireland
CX Isla de Navidad
JT Isla Johnston
NU Isla Niue
WK Isla Wake
PU Islands Miscellaneous
CT Islas Canton y Enderbury
CC Islas Cocos (Keeling)
CK Islas Cook
FO Islas Feroe
HM Islas Heard y Mc Donald
MI Islas Midway
PN Islas Pitcairn
SB Islas Salomón Británico
SJ Islas Svalbard y Jan Mayen
TK Islas Tokelau
WF Islas Wallis y Futuna
IL Israel
IT Italy
YU Iugoslavia
CI Ivory Coast
JM Jamaica
JP Japan
JO Jordan
KM Kamoras Islands
KH Kampuchea Democrática
KY Kayman Islands
KE Kenya
KD Korea, Democratic People’s
KP Korea, Democratic People’s
KR Korea, Republic of
KW Kuwait
LD Lao People’s Democratic
LB Lebanon
LS Lesotho
LR Liberia
LY Libyan
LI Liechtenstein
LU Luxembourg
MO Macau
MG Madagascar
MW Malawi
MY Malaysia
MV Maldivas
ML Mali
MT Malta
MQ Martinique
MR Mauritania
MU Mauritius
MX Mexico

Continued on next page
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Table 1 – continued from previous page
MC Monaco
MN Mongolia
MS Montserrat
MA Morocco
MZ Mozambique
NA Namibia
NR Nauru
NP Nepal
NL Netherlands
AN Netherlands Antilles
NC New Caledonia
NZ New Zealand
NI Nicaragua
NE Niger
NG Nigeria
NF Norfolk Island
NO Norway
NH Nuevas Hébridas
OM Oman
PC Pacific Islands
PK Pakistan
PA Panama
PG Papua New Guinea
PY Paraguay
PE Peru
PH Philippines
PL Poland
PT Portugal
PR Puerto Rico
QA Qatar
LA Republic
RE Réunion
RO Romania
RW Rwanda
PM

S. Pedro y Miguelón

LC Saint Lucia
VC Saint Vincent
WS Samoa
KN San Cristóbal-Nieves-Anguila
SM San Marino
ST Sao Tome and Principe
SA Saudi Arabia
SC Seichelles
SN Senegal
SL Sierra Leone
SK Sikkim
SG Singapur
SO Somalia

Continued on next page
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Table 1 – continued from previous page
ZA South Africa
ES Spain
LK Sri Lanka
SH St. Helena
SD Sudan
SR Suriname
SZ Swaziland
SE Sweden
CH Switzerland
SY Syrian Arab Republic
TW Taiwan
TZ Tanzania
TH Thailand
TG Togo
TO Tonga
TT Trinidad and Tobago
TN Tunisia
TR Turkey
TC Turks and Caicos Islands
UG Uganda
UA Ukrainian RSS
AE United Arab Emirates
GB United Kingdom
US United States
UP United States Pacific
HV Upper Volta
SU URSS
UY Uruguay
VU Vanuatu
VA Vatican City State
VE Venezuela
VN Viet Nam
EH Western Sahara
YE Yemen
YD Yemen, Democratic
ZR Zaire
ZM Zambia
nd Not defined

publication level

code value
CT Scientific/technical
DI Divulgation
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alphabet of title

code value
A Basic Roman
B Extensive Roman
C Cirillic
D Japanese
E Chinese
K Korean
O Another alphabet

language

code value
en English
pt Portuguese
es Spanish
af Afrikaans
ar Arabic
bg Bulgarian
ch Chinese
cs Czech
da Danish
nl Dutch
eo Esperanto
fr French
de German
gr Greek
he Hebrew
hi Hindi
hu Hungarian
in Indonesian
ia Interlingua
ie Interlingue
it Italian
ja Japanese
ko Korean
la Latin
no Norwergian
pl Polish
ro Romanian
ru Russian
sa Sanskrit
sh Serbo-Croat
sk Slovak
sn Slovenian
sv Swedish
tr Turkish
uk Ukrainian

Continued on next page
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Table 2 – continued from previous page
ur Urdu
zz Other
gl Galician
eu Basque
ca Catalan

frequency

code value
? Unknown
A Annual
B Bimonthly (every two months)
C Semiweekly (twice a week)
D Daily
E Biweekly (every two weeks)
F Semiannual (twice a year)
G Biennial (every two years)
H Triennial (every three years)
I Three times a week
J Three times a month
K Irregular (known to be so)
M Monthly
Q Quarterly
S Semimonthly (twice a month)
T Three times a year
W Weekly
Z Other frequencies

indexing coverage

code value
BA Biological Abstracts
EM Excerpta Medica
IM Index Medicus
LL LILACS
SP Salud Publica

acquisition priority

code value
1 Indispensable
2 Dispensable because exists in the Country
3 Dispensable because exists in the Region

38 Chapter 6. Programs for local server



pcprograms Documentation, Release 4.0.050

state

code value
AC Acre
AL Alagoas
AM Amazonas
AP Amapá
BA Bahia
CE Ceará
DF Distrito Federal
ES Espírito Santo
FN Fernando de Noronha
GO Goiás
MA Maranhão
MG Minas Gerais
MS Mato Grosso do Sul
MT Mato Grosso
PA Pará
PB Paraíba
PE Pernambuco
PI Piauí
PR Paraná
RJ Rio de Janeiro
RN Rio Grande do Norte
RO Rondônia
RR Roraima
RS Rio Grande do Sul
SC Santa Catarina
SE Sergipe
SP São Paulo

article status

code value
1 Available

stitle

code value
Acta Cir. Bras. Acta Cirurgica Brasileira
Bragantia Bragantia
Braz. J. Chem. Eng. Brazilian Journal of Chemical Engineering
Braz. J. Genet. Brazilian Journal of Genetics
Braz J Med Biol Res Brazilian Journal of Medical and Biological Research
Braz. J. Phys. Brazilian Journal of Physics
Cad. CEDES Cadernos CEDES
Cad. Saúde Púbica Cadernos de Saúde Pública

Continued on next page
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Table 3 – continued from previous page
Ci. Inf. Ciência da Informação
Ciênc. Tecnol. Aliment. Ciência e Tecnologia de Alimentos
DELTA DELTA: Documentação de Estudos em Lingüística

Teórica e Aplicada
Dados Dados
Educ. Soc. Educação & Sociedade
Genet. Mol. Biol. Genetics and Molecular Biology

J. Venom. Anim. Toxins
Journal of Venomous Animals and Toxins

J. Braz. Chem. Soc.
Journal of the Brazilian Chemical Society

J. Braz. Comp. Soc.
Journal of the Brazilian Computer Society

Mem. Inst. Oswaldo Cruz Memórias do Instituto Oswaldo Cruz
Pesq. Vet. Bras. Pesquisa Veterinária Brasileira
Psicol. USP Psicologia USP
Rev. bras. Bot. Revista Brasileira de Botânica
Rev Bras Cir Cardiovasc Revista Brasileira de Cirurgia Cardiovascular
Rev. bras. Ci. Solo Revista Brasileira de Ciência do Solo
Rev. bras. Ci. Soc. Revista Brasileira de Ciências Sociais
Rev. bras. Geocienc. Revista Brasileira de Geosciences
Rev. bras. Hist. Revista Brasileira de História
Rev Panam Salud Publica Revista Panamericana de Salud Pública
Rev. Fac. Educ. Revista da Faculdade de Educação
Rev. Microbiol. Revista de Microbiologia
Rev Odontol Univ São Paulo Revista de Odontologia da Universidade de São Paulo
Rev. Saúde Pública Revista de Saúde Pública
Rev. Inst. Med. trop. S. Paul Revista do Instituto de Medicina Tropical de São Paulo
Sci. agric. Scientia Agricola
Salud pública Méx Salud Pública de México

illustrative material type

code value
nd no illustrative material
ilus figure
gra graphic
map map
tab table

version

code value
3.1 3.1
4.0 4.0
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from

code value
00000000 00000000

to

code value
00000000 00000000

keyword priority level

code value
m main
s secondary

toccode

code value
1 title
2 sectitle

scheme

code value
nd No Descriptor
decs Health Science Descriptors

ftp

code value
art article based - a PDF file for each article
iss issue based - a PDF file for each issue
na Not Available

usersubscription

code value
na Not Available
reg Electronic Registration
sub Regular Subscription

6.1. Code Manager 41
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id

code value
nd Not defined

stud area

code value
Agricultural Sciences Agricultural Sciences
Applied Social Sciences Applied Social Sciences
Biological Sciences Biological Sciences
Engineering Engineering
Exact and Earth Sciences Exact and Earth Sciences
Health Sciences Health Sciences
Human Sciences Human Sciences
Linguistics, Letters and Arts Linguistic, Literature and Arts

rid

code value
nd Not defined

dateiso

code value
00000000 00000000

count

code value
0 0

pii

code value
nd Not defined

pages

code value
0-0 0-0
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issue status

code value
1 Available
0 Not available
2 Partial available

idiom interface

code value
es Spanish
pt Portuguese
en English

table of contents

code value
en Table of Contents
pt Sumário
es Sumario

sponsor

code value
nd Not definido

orgname

code value
nd nd

no

code value
0 0

6.1. Code Manager 43
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scielonet

code value
1 SciELO Brasil
2 SciELO Chile
3 SciELO Salud Pública
4 SciELO BEEP
5 SciELO Ecler
6 SciELO Cuba
7 SciELO Colombia
8 SciELO Costa Rica
9 SciELO Uruguay
10 SciELO Argentina
11 SciELO Biodiversidade
12 SciELO Bolivia
13 SciELO España
14 SciELO Jamaica
15 SciELO México
16 SciELO Perú
17 SciELO Portugal
18 SciELO Venezuela
19 SciELO Adolec
20 SciELO Social Sciences
21 SciELO Paraguay
22 SciELO Ecuador
23 SciELO Caribbean
24 SciELO South Africa

issn type

code value
CDROM CD-ROM ISSN
DISKT Diskette ISSN
ONLIN On line ISSN
PRINT PRINT ISSN

orgdiv1

code value
nd nd

orgdiv2

code value
nd nd
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orgdiv3

code value
nd nd

orgdiv

code value
nd nd

ctdbid

code value
CT CT - Clinicaltrials.gov
ACTR ACTR - Australian Clinical Trials Registry
ISRCTN ISRCTN - International Standard Randomised Controlled Trial Number Register
NTR NTR - Nederlands Trial Register
UMIN UMIN - University Hospital Medical Information Network
ChiCTR ChiCTR - Chinese Clinical Trial Register

doctype

code value
au audio
pr press release
vi video

deposid

code value
1 Unicamp
2 Unifesp
3 Unesp
4 USP
5 ITA
6 UFSCar
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ftype

code value
audiogram audiogram
cardiogram cardiogram
cartoon cartoon
chart chart
chemical structure chemical structure
dendrogram dendrogram
diagram diagram
drawing drawing
exihibit exihibit
graphic graphic
illustration illustration
map map
medical image medical image
other other
photo photo
photomicrograph photomicrograph
plate plate
polysomnogram polysomnogram
schema schema
workflow workflow

lictype

code value
open-access open access
nd not defined

pubtype

code value
epub electronic publication
ppub print publication

hcomment

code value
0 people can not comment
1 people can comment

46 Chapter 6. Programs for local server



pcprograms Documentation, Release 4.0.050

license_text

code value
BY <a rel=”license” href=”http://creativecommons.org/licenses/by/3.0/”><img alt=”Creative Commons Li-

cense” style=”border-width:0” src=”http://i.creativecommons.org/l/by/3.0/80x15.png” /></a> All the
contents of this journal, except where otherwise noted, is licensed under a <a rel=”license”
href=”http://creativecommons.org/licenses/by/3.0/”>Creative Commons Attribution License</a>

BY-
NC

<a rel=”license” href=”http://creativecommons.org/licenses/by-nc/3.0/”><img alt=”Creative Commons Li-
cense” style=”border-width:0” src=”http://i.creativecommons.org/l/by-nc/3.0/80x15.png” /></a> All the
contents of this journal, except where otherwise noted, is licensed under a <a rel=”license”
href=”http://creativecommons.org/licenses/by-nc/3.0/”>Creative Commons Attribution License</a>

nd <p> </p>

ref-type

code value
aff Affiliation
app Appendix
author-notes Author notes
bibr Bibliographic reference
boxed-text Textbox or sidebar
chem Chemical structure
contrib Contributor
corresp Corresponding author
disp-formula Display formula
fig Figure or group of figures
fn Footnote
kwd Keyword
list List or list item
other None of the items listed
plate Plate
scheme Scheme
sec Section
statement Statement
supplementary-material Supplementary information
table Table or group of tables
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fntype

code value
abbr Abbreviations
com Communicated-by information
con Contributed-by information
conflict Conflict of interest statements
corresp Corresponding author information not identified separately, but merely footnoted
current-aff Contributor’s current affiliation
deceased Person has died since article was written
edited-by Contributor has the role of an editor
equal Contributed equally to the creation of the document
financial-disclosure Statement of funding or denial of funds received in support of the research on which an

article is based
on-leave Contributor is on sabbatical or other leave of absence
other Some footnote type, other than those enumerated.
participating-
researchers

Contributor was a researcher for an article

present-address Contributor’s current address
presented-at Conference, colloquium, or other occasion at which this paper was presented
presented-by Contributor who presented the material
previously-at Contributor’s previous location or affiliation
study-group-
members

Contributor was a member of the study group for the research

supplementary-
material

Points to or describes supplementary material for the article

supported-by Research upon which an article is based was supported by some entity

listtype

code value
order Ordered list. Prefix character is a number or a letter, depending on style
bullet Unordered or bulleted list. Prefix character is a bullet, dash, or other symbol
alpha-lower Ordered list. Prefix character is a lowercase alphabetical character
alpha-upper Ordered list. Prefix character is an uppercase alphabetical character
roman-lower Ordered list. Prefix character is a lowercase roman numeral
roman-upper Ordered list. Prefix character is an uppercase roman numeral
simple Simple or plain list (No prefix character before each item)

48 Chapter 6. Programs for local server



pcprograms Documentation, Release 4.0.050

sec-type

code value
cases Cases/Case Reports
conclusions Conclusions/Comment
discussion Discussion/Interpretation
intro Introduction/Synopsis
materials Materials
methods Methods/Methodology/Procedures
results Results/Statement of Findings
subjects Subjects/Participants/Patients
supplementary-material Supplementary materials

6.2 Title Manager

• Single-user program

• Visual Basic

• used in local server

• Usage: to manage the databases: title, issue and section, it means, respectively the data of journals, their issues
and sections of the table of contents.

Contents:

6.2.1 Opening the program

To open the program, use Windows menu, select SciELO, then Title Manager
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6.2.2 Journal

Creating a new record

1. Select File-> Open-> Journals-> New.

2. Write the title of the journal and click on Open button.

3. Register the journal data. Read Journal form.

4. Click on Save button

Opening a record to edit the journal data

1. Select File-> Open-> Journals-> Open
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2. Select the title you want to open

3. Register the journal data. Read Journal form.

4. Click on Save button

Deleting records of journals and their issues

It is used to remove records of one or more titles.

Use it only if you are sure the journal HAS NEVER BEEN PUBLISHED.

IT Is MANDATORY to keep all the titles registered, although ceased or removed off the collection, they must keep
published.

If the journal has to be disabled, read Journal history.

It deletes the records of the databases title and issue locally. So, only after GeraPadrao, the title will be deleted from
the website.

1. Select File-> Open-> Journals-> Delete
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2. Select the titles to be removed.

3. Click on Remove button.
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Journal form

ISSN

Field: 400

ISSN – print or electronic – which can not be changed because it is used as a key

Publication Title

Field: 100

Main title or title proper of the serial, in the language and form in which it appears.

Examples:

• Publication title: British journal of surgery

• Publication title: Journal of pediatrics

• Publication title: Pediatrics (London)

• Publication title: Pediatrics (New York)

• Publication title: Abboterapia (English ed.)

• Publication title: Abboterapia (Spanish ed.)
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Subtitle

Field: 110

• Publication Title: MMWR Subtitle: morbidity and mortality weekly report

Short Title

Field: 150

Enter the abbreviated title respecting the upper case letters, lower case letters and accentuation of the corresponding
language, according to the standard.adopted by the journal

ISO Short Title

Field: 151

Enter the abbreviated title respecting the upper case letters, lower case letters and accentuation of the corresponding
language, according to ISO standard 4-1984 and List of serial title word abbreviations. This field is mandatory for
titles indexed in LILACS and/or MEDLINE. Examples:

• Publication title: West Indian medical journal Abbreviated title: West Indian med. j.

• Publication title: Abboterapia (English ed.) Abbreviated title: Abboterapia (Eng. ed.)

• Publication title: Pediatrics (London) Abbreviated title: Pediatrics (London)

Section

Field: 130

Enter in this field the name of the Section, Part or Supplement, if exists, as it appears on the title page or its substitute,
recording the first letter of the first word in upper case. Examples:

• Publication Title: Acta ophtalmologica Title Section/Part: Supplement

• Publication Title: Bulletin signaletique Section/Part: Section 330 Title Section/Part: Sciences pharmacologiques

Parallel Titles

Field: 230

Enter parallel titles in accordance with the sequence and typography in which they appear on the title page or its
substitute, according to ISBD(S) rules. In case of more than one parallel title, enter them in the sequence which
appears on the title page, separated by ENTER (one by lin - . Examples:

• Publication Title: Archives of toxicology Parallel Title: Archiv fur Toxikologie

• Publication Title: Arzneimittel Forschung Parallel Title: Drug research
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Other Titles

Field: 240

Other forms of the title which appear in the serial such as: cover title which differs from the title on the title page,
full title and other variant forms of the title. Include here lesser variants of the title proper which do not require a new
record, but which justify their retrieval. In case of more than one title form, enter them in the sequence in which they
appear, separated by ENTER (one by lin - Examples:

• Publication Title: Obstetrics and Gynecology Clinics of North America Other Forms of Title: Obstetrics and
Gynecology Clinics

• Publication Title: Journal of the National Cancer Institute Other Forms of Title: JNCI: Journal of the Na-
tional Cancer Institute

Old Title

Field: 610

Enter the preceding title, if there is one. If this title exists in the collection, in the journal homepage is presented a link
from the current title to the preceding and vice-versa.

New Title

Field: 710

Enter the subsequent title of the serial. If this title belongs to the collection, in the site there will be a link between the
title and its subsequent title, and vice versa.

Is Supplement

Field: 560

Link note: Note which acts as a link between the title of the supplement/insert and the main title or title proper. Enter
the main title or title proper to which the supplement/insert is linked.

Has Supplement

Field: 550

Link note: Note which acts as a link between the main title or title proper and its supplements/inserts (titles generally
published in separate form, with its own numbering, which complements the main titl - Enter in this field the title of
the supplement/insert.
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Registering the subject areas

Mission

Field: 901

Enter in this field the mission of the journal in English, Spanish and Portuguese. This is used in the home page of the
journal. Examples:

• Misión: To publish the results of original research which contribute significantly to knowledge in medical and
biological sciences

• Misión: La revista publica contribuciones originales de investigadores de todo el mundo en las áreas de par-
asitología, microbiología, medicina tropical, así como estudios básicos en bioquímica, inmunología, biología
celular y molecular, fisiología, y genética relacionados con esas áreas

Subject/Descriptors

Field: 440

Descriptors; Standard terms used for the subject representation of the serial being described. Terms must be entered
in capital letters. Cooperating Centers of BIREME System should use terms taken from DeCS (Descriptors in Health
Scienc - . In case of more than one descriptor, enter them in sequence, separating them by ENTER, an item by line.
Enter a maximum of 4 descriptors. Examples:

• Descriptors: OCCUPATIONAL MEDICINE

• Descriptors: PEDIATRICS

• Descriptors: NEUROLOGY PEDIATRICS
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• Descriptors: GYNECOLOGY OBSTETRICS

Study Area

Field: 441

Select one or more subjects related to the journal. The site uses this content to presents the journal title in the site in
the list by subject.

Indexing Coverage

Field: 450

Indexing Coverage – Enter in this field all the database in which the title is indexed. Each database in one line.
Examples: - IM- Index Medicus - LL- LILACS - IL- Index Medicus Latino Americano - EM- Excerpta Medica - BA-
Biological Abstracts - SP- LILACS-SP

Registering formal information

Initial Date

Field: 301

Enter the date of the first issue of the journal in ISO format (year in 4 digits, month 2 digits, day in 2 digits). Examples:

• Initial date: Jan./Mar. 1974 19740100

6.2. Title Manager 57



pcprograms Documentation, Release 4.0.050

• Initial date: 1987 19870000

• Initial date: Sept. 1988 19880900

Initial Volume

Field: 302

Enter the initial volume in arabic numerals. Omit this information for serials which do not include clear information
on the volume. Examples:

• Initial volume: 1

• Initial volume: 4

Initial Number

Field: 303

Enter the initial number in arabic numerals. Examples:

• Initial number: 1

• Initial number: 2

Terminate Date

Field: 304

Date, in ISO format, in which the journal was published for the last time.Examples:

• Termination date: 1984 19840000

• Termination date: 1988 19880000

Final Volume

Field: 305

Number of the last published volume of the serial. Enter the final volume in arabic numerals. Examples:

• Final volume: 10

• Final volume: 12

Final Number

Field: 306

Enter the final number in arabic numerals. Examples:

• Final number: 7

• Final number: 10
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Frequency

Field: 380

Code which identifies the intervals of time in which the issues of the serial are published.

Publication Status

Field: 50

Code which identifies if this title can be or already is published in the collection. In other words, if this title which can
be processed by gerapadrao.

• Current – title which can be accessed on the web site of the collection

• Unknow – title which belongs to the collection, although it is not ready to be published Ceased – title which
does not belong to the collection but it is related to title of the collection

• Reports only – title which does not belong to the collection but it is used in reports

Alphabet

Field: 340

Enter data in this field the alphabet of the Original Title of the journal title.

Classification

Field: 430

Subject classification number assigned to the serial according to the classification system used by the Center.

Text Idiom

Field: 350

Languages in which the articles are published, including the translations. This field is related to the presentation of all
the full texts of the site.

Abstract Idiom

Field: 360

Languages of the Abstracts

National Code

Field: 20

Code which identifies the title in the national system of serials of each country (or its equivalent) with the purpose
of facilitating the transfer of data between this and other related systems. Enter in this field the code assigned by the
institution responsible for the national system of serials of each country (or its equivalent). Examples:

6.2. Title Manager 59



pcprograms Documentation, Release 4.0.050

• National Code: 001060-X (Code assigned by the Brazilian National Union List)

• National Code: 00043/93

Standard

Field: 117

Standard used to the bibliographic references presentation. This content is related to the Markup program.

Controled Vocabulary

Field: 85

Enter in this field the controlled vocabulary used to the key words

Type of Literature

Field: 5

Type of literature

Treatment Level

Field: 6

Level of publication

Field: 330

SECS Code

Field: 37

Enter in this field the number assigned by BIREME which identifies the title in SeCS (Health Science Serials) database.
Mandatory field for Cooperating Centers which input data to SeCS database. This field is used by the system to
generate the holding files which are to be transfered to SeCS database. This field must be entered if SECS is recorded
in Field 040; Related Systems. Examples:

• SECS Number: 2

• SECS Number: 4

MEDLINE Code

Field: 420

MEDLINE Code (Journal Cod - of the title when it is indexed in MEDLINE databases.
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MEDLINE Short Title

Field: 421

Short title for MEDLINE

Registering publisher and sponsor

Publisher

Field: 480

Name of the publisher and/or issuing body of the serial. Enter the name of the publisher responsible for the serial as it
appears in the publication. When the publisher is the same as the issuing body, it is not necessary to repeat it in this
field, except when it is indispensable for purposes of acquisition. In case of more than one publisher, enter the first
one that appears on the publication or the one that coincides with the place of publication. Examples: - Publisher:
Pergamon Press - Publisher: Plenum Press

Publisher’s Country

Field: 310

Country of the Publication

6.2. Title Manager 61



pcprograms Documentation, Release 4.0.050

Publisher’s State

Field: 320

State/Province – Enter in this field the location in the country of the publication, but not the city or town. Examples:

• State/Province: SP

• State/Province: RJ

Publisher’s City

Field: 490

Enter the name of the city in full in the language in which it appears in the publication. When the title appears in more
than one language, enter the city in the language of the title proper. When it is not possible to determine the place of
edition and/or publication of the serial, enter the abbreviation s.l. Examples:

• Place of publication: Port of Spain

• Place of publication: London

• Place of publication: s.l

Address

Field: 63

Enter in this field the address and phone numbers. This data is presented in the foot page and is used to conctact the
publisher.

Examples:

• Rua Capitão Adelmio Norberto da Silva, 736 14025-670 Ribeirão Preto, SP; Brasil Telephone and Fax: (55
16) 621.8540, 620.1251, 620.1253

• Avenida Lineu Prestes, 2227; Caixa Postal 8216 Cidade Universitária Armando de Salles Oliveira 05508-
900 São Paulo, SP; Brasil Telefone: (55 11) 818.7861 Fax: (55 11) 818.7413

Electronic Address

Field: 64

Enter in this field the e-mail address of the publication, used in the process of publication. DO NOT USE PERSONAL
e-mails. This information is presented in the foot page of the site.

Sponsor

Field: 140

Enter the name of the financial sponsors
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Registering license or copyright

Text provided by Creative Commons site according to the license choice

Field: 540tl

Enter in HTML in English, Portuguese, Spanish, a text, which inform the license to use the content of the journal
(Creative Commons).

Copyrighter

Field: 62

Copyrighter Examples: - Brazilian Journal of Medical and Biological Research - Sociedade Brasileira de Genética -
Instituto Universitário de Pesquisas do Rio de Janeiro - Revista Brasileira de Ciências Sociais
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Registering the history of journal’s status in the collection

Journal history

Field: 51abcd

Date and status which identify the changes of the journal’s status in the collection. Date must be in ISO format
YYYYMMDD Status can be:

• Ceased (D): journal will not be published any more.

• Current (C): journal published currently.

• Suspended (S):journal is no longer according to collection´s criteria. In the future it can become current.

Journal’s status history in this collection

Field: 51

Repetitive.

• subfield a: initial date, ISO format

• subfield b: status which value is C

• subfield c: final date, ISO format

• subfield d: status which value is D or S

64 Chapter 6. Programs for local server



pcprograms Documentation, Release 4.0.050

Registering data for the website
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Acronym (Lowercase and/or Uppercase letters)

Field: 930

Enter in this field the acronym of the journal, max 8 characters length, in capital letter or not. It must be unique
comparing to the other titles. It is used for the name of the folder in which are saved all the files related to the journal
(markup, body, images, et - and also used for the prefix to the sections code of the journal.

Acronym

Field: 68

Name of the folder which contains the files of the journals and which is in serial folder. It is automatically filled as
filling in the field acronym of the title of the journal

ISSN Type

Field: 35

Identifies the type of the CURRENT ISSN.

Current ISSN

Field: 935

Enter the current ISSN. It can be different or equal to the ISSN used as ID, but it is usually the online ISSN.

URL of the main collection

Field: 690

Enter the URL of the main collection site. If the journal is published in SciELO Brazil, then www.scielo.br

URL of Submission Online

Field: 692

Enter the URL of the submission site

URL of the journal

Field: 69

If the journal is published in another site, enter in this field the other site location

FTP

Field: 66

Enter in this field the information about PDF files of the articles. not available – PDF unavailables art (article base - –
one PDF file for each article iss (issue base - – one PDF file for one issue
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User Subscription

Field: 67

Identifies how to access to the articles by subscription. Select the corresponding option: - sub ; regular subscription -
reg; electronic registration - na; not available, no hay subscription

SciELO Net

Field: 691

Select the collections to which the journal belong.

Registering the record data

Notes

Field: 900

Enter in this field, in free style, all information of interest to the Center about the serial.

Center Code

Field: 10

Code which identifies the center responsible for the creation of the bibliographic records
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Identification Number

Field: 30

Sequential number assigned and controlled by the Cooperating Center which identifies the serial in the database. Enter
in this field the number corresponding to the title being described. This field is used in the system in order to link the
title record with its corresponding issues, therefore being mandatory. Examples:

• Record identification: 1050

• Record identification: 415

Creation Date

Field: 940

Automatically filled with the date of the registration.

Documentalist (Creation)

Field: 950

Initials of the responsible for the register creation.

Update Date

Field: 941

Automatically filled with the updating date.

Documentalist (Update)

Field: 951

Initials of the responsible for the register updating.

6.2.3 Sections

It manages all the sections of the table of contents of the all the journal issues.

Opening the journal sections form

1. Select File-> Open-> Sections
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2. Select a title and click on Open button

Sections form

As opening the form, it will be presented a screen with four columns:

• Seccode (code sections)

• titles of the section in Spanish

• titles of the section in Portuguese

• titles of the section in English

The code of sections are formed by the Journal acronym, followed by 010, or 020, or 030, and, so on.

The title of the sections may or not be in all the languages of the interface.

Fig 1a - List of sections of the journal

The list can be rearranged, by clicking on any column. For example, clicking on code column, the list will be sorted
by code.
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Fig 1b - List of sections, ordered by the English column

Creating a section

1. Register the section code according to the acronym format, followed by 010, or 020, or 030, and successively.
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Figure 2 - Field to enter the section code

2. Register the fields for section title

Figure 3 - Fields to enter the section titles

3. Click on Insert button

4. Click on Save button

NOTES:
Only after clicking on the Save button, the record will be up to date with all the changes.

Editing the section

1. Click on the line of the section to edit. Code and section titles go to the fields.
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Figure 4 - selected section to edit or delete

2. Edit the section titles

3. Click on Insert button

Figure 5 - Insert button

4. Click on Save button
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NOTES:
Only after clicking on the Save button, the record will be up to date with all the changes.
It is allowed to change only the sections which are not in use.

Deleting a section

1. Click on the line of the section to be deleted. Section code and titles will go to their fields.

Figure 6 - selected section to edit or delete

2. Click on Remove button

Figure 7 - Remove button

3. Click on Save button

NOTES:
Only after clicking on the Save button, the record will be up to date with all the changes.
It is allowed to change only the sections which are not in use.

Figure 8 - Buttons: Save, Close, Help

Section database

ISIS Base. A record by title. Each record contains the following tags:
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tag
035 ISSN. Corresponds to the field of 400 of TITLE
048 subfield l Language of table of contents’ header
048 subfield h title for table of contents’ header (Table of contents (en), Sumario (pt), Tabla de Contenido (es))
049 subfield c code of the section
049 subfield l language of the section
049 subfield t title of the section
091 Date ISO to register the update date
100 Journal’s title. Corresponds to the same field of TITLE.
930 Journal’s acronym in uppercase

6.2.4 Issues

Opening the program

1. Select File-> Open-> Issues

2. Select a title and click on Open button

Important concepts

Read:

• type of issues

• sequential number

• folders structure

Issues form

From this screen, you have the following options:

• List the issues

• Create an issue

• Edit an issue

• Delete an issue
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Listing issues

1. Clicking on the

button to list all the issues.

1. If you want to list all the numbers of a given volume, fill the volume field, then click on the

button.
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The first highlighted line in orange is one example of ahead numbers of the year 2009.

The second highlighted line in blue is an example of a regular number.

The third highlighted line in purple is an example of press release number of v43n5 (blue).

The fourth line highlighted in red is an example of number press release ahead to 2009 (orange).

The lines highlighted in green are examples of supplement of volume.
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The lines are highlighted examples of numbers review / provisional.

Identifying the issue and its sequential number

To create, edit or remove, identify the issue, filling the volume, issue, supplement, complement, sequential number.
Read about it.
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Issue identification

label field
vol-
ume

31

sup-
ple-
ment
of vol-
ume

131

num-
ber

32

sup-
ple-
ment
of
num-
ber

132

com-
ple-
ment

41

se-
quen-
tial
num-
ber

36 The sequential number is the year followed by the order for publication of the issue within a year.
The sequential number is part of the PID of the issue. Must not be modified after publication of
the issue. It also is used for the presentation of issues on the page all the issues, giving their order
of presentation in the table.

Identifying regular issues

Fill the volume and number.

The sequential number is the year followed by the order of the issue within a year. Eg: 20101 (first issue within a
year).
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Identifying supplements

When they exist, fill volume, supplement of volume (when there is no number), number, and supplement of number.

If the supplement is identified only with the word Supplement, fill in with 0, otherwise the label which identifies the
supplement, for example, 1, A, etc.

On the site, so that all supplements are presented after the regular issues within a year, the sequential numbers of the
supplements must be greater than the sequential number of the last regular issue. Eg: If there are 4 regular numbers in
the year, then the sequential number for the supplements starts in 5.
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Identifying ahead or review / provisional issues

Fill in the number field the word ahead, for ahead issue. By convention its sequential number is 50. Fill in the number
field the word review, for review or provisional issue. By convention its sequential number is 75.

The sequential number is the year followed by the order of the issue within year, but by convention:

• Ahead is equal to 50

• Review / provisional is equal to 75
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Indentifying press release issues

Populate the same fields in accordance with the rules above, plus pr in the complement. The sequential number is the
year followed by the order of the issue within a year, but by convention starts in 100.
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Problems on filling the sequential number

When the sequential number and the issue identification do not match, the program presents two conflict situations:
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Sequential number belonging to another issue

When the user informs a sequential belonging to another issue, the program does not open the issue data, and informs
the sequential number belongs to another issue.

It is also possible that the user have misinformed the issue identification and not the sequential number. The user is
responsible for checking and correcting the data filled in before proceeding.
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Mistake or replacement?

When the user reports an issue identification and a sequential number which do not match and the sequential number
DOES NOT BELONG TO another issue, the program allows to:

• open the issue, using the identification informed, but correcting its sequential number

• change the issue’s sequential number to the informed one

Warning: The sequential number is part of the PID, so it must not be changed if the issue is
already published on the site. The program allows the change of sequence number, if it does not
belong to any other issue. The program does not know if the issue is already published or not.
The user must be responsible for knowing it.

Creating/editing an issue

1. Identify the issue. Read Issue identification.

2. Click on the Open button
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General data

Status

Field: 42

Status of the issue. It indicates if the issue would be available on the website.

Number of documents

Field: 122

Number of documents (articles and texts) of the issue. Converter checks this value with the amount of files in the
folder serial/<acronimo>/<issueid>/markup.

Date ISO

Field: 65

Date of publication of the issue in ISO format (YYYYMMDD) = 4 digit year, followed by two digits for month, 2
digits for day, with possible 00 if the day is not important.

This date is used to generate the bibliographic strip (next screen) and it is also used by Converter to check the date.

Issue’s title

Field: 33
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This field must be filled, if there is/are the issue’s title. Thematic or special issues usually have it.

Cover

Field: 97

Part

Field: 34 Into disuse.

ISSUE ISSN

Field: 35

Fill it with the ISSN used by the journal at the time this issue was published.

Editor issue

Field: 62

This field must be filled, if there is/are the issue’s editor.

Sponsor

Field: 140

This field must be filled, if there is/are the issue’s sponsor.

Standard

Field: 117

Standard used by the journal.

Markup done

Field: 200

It indicates whether the Markup of this issue has already been done. If so, the issue will not be listed on Markup
program.

Controlled Vocabulary

Field: 85

Controlled vocabulary used by the journal.
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Bibliographic strip

Field 43, one occurrence for each language (es, en, pt).

• Subfield l: possible values: es (for Spanish), pt (for Portuguese) or en (for English)

• Subfield t: abbreviated title, value from the Title/Field 150.

• Subfield v: volume

• Subfield w: Supplement of Volume

• Subfield n: number

• Subfield s: Supplement of number

• subfield c: publisher location

• Subfield m: month of publication, generated automatically by the ISO date provided in the previous screen,
however, editable

• Subfield y: year of publication, automatically generated by the ISO date provided in the previous screen. This
value is checked against ISO date.
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Table of contents

On this screen, the table of contents.

The user must choose the sections that are part of the issue.

The program will present the table below, sorted by language.

If there are missing sections, the user must click on Create sections which open a screen for the Sections’ form.

Header of table of contents

Field: 48, one occurrence for each language (es, pt, en).

• Subfield l: language header. pt (Portuguese), es (Spanish), en (English)

• Subfield h: header. Sumario (en), Tabla de contenido (es), Table of Contents (en)

Sections Data

Field: 49

• Subfield l: language of the section pt (Portuguese), es (Spanish), en (English)

• Subfield c: section code/id, formed by acronym, followed by 010, or 020, or 030, and so on

• Subfield t: section title
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Creative Commons License

Text provided by the Creative Commons site in accordance with the choice of license

Field: 540, for each language an occurrence (es, en, pt).

• Subfield l: language of the license text (pt (Portuguese), es (Spanish), en (English))

• Subfield t: license text in HTML format

Deleting issue

1. Informing the issue and its sequential number 1. Click on Remove button

NOTE: This option only delete the record of the issue database, does not remove the issue from the website.

Issue database

ISIS Base. One record per issue. Each record contains the following tags:

030 Short Title. Corresponds to 150 of TITLE
031 Volume
032 Number
033 Title of the issue
034 Party
035 ISSN. Corresponds to the field of 400 TITLE
036 Seq Num

Continued on next page
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Table 4 – continued from previous page
041 Complement. Identify a press release number||
042 Status
043 Legend
043 v volume
043 w Supplement volume
043 n number
043 s Supplement number
043 y Year
043 c City
043 m last
048 l Language header summary
048 h Header Summary (Table of contents, summary, etc.)
049 c Code sections
049 l Language Sections
049 t Title of the sections
062 Editor of the issue
064 Date of publication. for the year (four digits), m month (two digits)
065 Date ISO
085 Controlled Vocabulary
091 Date ISO to register the update date||
097 Cover
117 Standard (vancouver, ISO, ABNT, etc.)
122 Number of documents
130 Title of the journal. Corresponds to the field of 100 of TITLE database||
131 SuplVol
132 SuplNum
140 Sponsor
200 Markup done
230 corresponds to the same field of TITLE database
540 Text provided by the Creative Commons site in accordance with the choice of license
700 position of the record on the basis of an issue. Value equal to 0, first record
701 Counter record type. Value of 1
706 type / name of the record. Value of i (of issue)
930 Journal’s acronym in uppercase
935 ISSN of the journal at the time the issue had been published. Corresponds to the field of 935 TITLE

6.3 Converter

• single-user program built in Visual Basic, to use only by a centralized server, denominated local server. It is
mandatory only one installation by SciELO collection or instance.

• Converter reads the files from markup and body folders, and the databases in title and issue folders, then gener-
ates a ISIS database in base folder of the corresponding journal issue.
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6.3.1 Opening the program

6.3.2 Checking the program version

To check the version of the program, see How to check the program version.

6.3.3 Changing the language of the program

To change the language of the program’s interface, see Change the language of the program.

6.3.4 Running the program

1. Select Files.

2. Fill the fields:
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• journal’s title: select the title of the journal.

• year: FILL ONLY if it is AHEAD or REVIEW number

• volume: fill it in with the volume

• supplement of volume: fill it in with the supplement of volume, if it exists

• number: fill it in with the number. If it is an ahead or review/provisional number, use ahead or
review, respectively

• supplement of number: fill it in with the supplement of number, if it exists

• part: fill it in, if it exists. Recently it is used to press release, fill it in with pr.
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3. Click on OK button.

4. Converter uses these data to identify the issue’s, markup and body folders. If the data are correct, the program
will list the markup files.

5. Click on Convert button.
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6. Converter will convert the selected files.

For each file, the program:

• extracts the marked data

• compares the issue’s data in the markup file and in the issue database, managed by Title
Manager->Issues.

If there is some conflicting data, the data are not converted to the database. It is a fatal error. The user
must check and correct the data in the markup document (using Markup program) and/or in issue
database (using Title Manager).

If the issue’s data is correct, the files are converted to the database and the result will be shown on
the screen.

Results:

• successfully converted: [], in red.

• converted, with errors: [X], in blue before its name. They have some markup errors, but not fatal
enough to avoid conversion. For example, markup error, probably identified by Parser, but not
corrected by the user.

• not converted: at the inferior part, in green. It is usually related to issue’s data, such as ISSN,
abbreviated title, volume and number, which do not match in the markup file and in the issue
database.

7. Clicking on each file in the result area and then on Result button, the user can see how the conversion run.

Successfully converted
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Converted, but no fatal error: markup error

Converted, but no fatal error: some bibliographic references not identified

Converter locates each bibliographic reference of the markup file in the body file, identifying the points
where [Links] must be inserted at the article page, in the website.
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Clicking on [Links], a window is open to display a list of links to the referenced fulltext.

If there are bibliographic reference location errors, Converter will present the result bellow:
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Not converted, because of fatal errors

6.4 XML SciELO

• DOS Batch program

• local server

This program generates XML and SGML files to PubMed and ISI.

For PubMed, there are two types of files:

• Journal data: http://www.ncbi.nlm.nih.gov/books/bv.fcgi?rid=helplinkout.section.files.Resource_File#files.
Resource_File_Format. Sent once or every time the journal data was changed.

• Articles data: http://www.ncbi.nlm.nih.gov/entrez/query/static/spec.html Sent one XML file for each issue.
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6.4.1 Installation

This program is installed in PROGRAMS_PATH on the local Server using the SciELO PC-Programs package, where
PROGRAMS_PATH is the path for all the SciELO PC programs.

The examples are considering PROGRAMS_PATH equal to c:\scielo.

It is also necessary to install java, if there is no java installed.

6.4.2 Configuration

Configuring the files and paths

Some configurations are done automatically as installing the PC Programs. The configuration files for all the PC
Programs is c:\scielo\bin\scielo_paths.ini.

This program use the following parameters of this configuration file:

; Serial Serial Directory=f:\serial\,required . . . ; xml_scielo
XML_SCIELO_PROGRAM_PATH=c:\scielo\xml_scielo PHP_EXE=c:\server\php\php.exe
JAVA_EXE=java PubMed_DIR_COPY=c:\scielo\serialSCI_LISTA_SITE=c:\scielo\web\proc\scilista.lst
PubMed_PROVIDER_ID=3081

Serial Directory it is the place for all the journal and issues data. So, it indicates to the program where to find the
data: c:\scielo\serial\title\title, c:\scielo\serial\<revistas>\<issue>.

XML_SCIELO_PROGRAM_PATH it indicates the place where the programs is installed. E.g.:
c:\scielo\xml_scielo.

PHP_EXE it indicates the full path to php.exe, used for XML transformation. E.g: c:\server\php\php.exe.

JAVA_EXE it indicates the full path to java or just java, if it is already in the PATH, used for XML transformation.
E.g: java.

PubMed_DIR_COPY it indicates the place where there Will be a copy of the generated files.

SCI_LISTA_SITE it indicates the list used to generate the website. This program uses this list to create another list,
used by itself.

PubMed_PROVIDER_ID it is the ID of the provider. SciELO is one of the providers whose ID is 3081, for all the
SciELO Collection.

6.4.3 Configuration of the data

If it is the first installation, you have some procedures to execute.

There is a file in c:\scielo\xml_scielo\config.example. You have to copy and rename to config.

Configure the files:

• PubMed\doi_conf.txt

• PubMed\config\config.seq

• PubMed\journals\journals.seq
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File doi_conf.txt

It contains the data of the Publisher and the prefix given by CrossRef, according to the agreement signed by CrossRef
and the SciELO of each country. IF YOUR SCIELO DOES NOT HAVE IT. SO THIS FILE MUST BE EMPTY.

INSTITUTION SPACE E-MAIL SPACE PREFIX

File config\config.seq

The file configconfig.seq is to informe to the program which articles or text should not be sent to PubMed, because
some kind of documents are not accepted. So by their section in the table of contents it is possible to know if the
document would be accept or not. So, this file contains the list of sections whose documents will not be accepted by
PubMed.

Acronym space sectionId
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File journals\journals.seq

This file journals\journals.seq contains data used to generate XML file of the journal: journals_acronimo.xml. This is
the first XML file which must be sent to PubMed in order to register the journal. Read more: http://www.ncbi.nlm.
nih.gov/books/bv.fcgi?rid=helplinkout.section.files.Resource_File#files.Resource_File_Format.

Its format is:

ACRONYM SPACE FIRST_YEAR_IN_PubMed SPACE SCIELO_URL SPACE ISSN

One line for each journal.
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6.4.4 Executing

It has to be executed using the command line in DOS.

Go to the folder where this program is installed. E.g.: c:\scielo\xml_scielo\proc.

In proc you will find three scripts:

• GenerateXML_all.bat: generates at the same time ISI and PubMed

• GenerateXML_ISI.bat: generates SGML to ISI

• GenerateXML_PubMed.bat: generates XML to PubMed
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Provide a list similar to scilist, to execute any of them.

The program will open the scilist file and you have to check it, and include or remove lines, according to what you
want to generate.

To generate also the XML file which contains journal data, journals_<acronimo>.xml, add one more parameter “YES”:

hcsm v13n2 YES

To generate ONLY the XML file which contains journal data, journals_<acronimo>.xml, the second parameter must
be “NONE” and third one must be YES.

hcsm NONE YES
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Programs for Markup computers

7.1 Markup

• single-user program, built in Visual Basic Application for Word, to descentralized use in any workstation.

• Its installation can be done in several computers, others than local server.

• tool to identify bibliographic elements in the articles and texts, according to SciELO DTD for article and for
text, based on standard ISO 8879-1986 (SGML - Standard Generalized Markup Language) and ISO 12083-1994
(Electronic Manuscript Preparation and Markup).

With this program, the user can:

• open the articles or text files

• identify the bibliographic elements in the file, by select them with the mouse or keyboard and then tagging them,
according DTD

• markup bibliographics references semiautomatically

• validate the identification according to article dtd.html#article and for text

• generate PMC XML (under development) http://dtd.nlm.nih.gov/publishing/3.0/. Read the instructions given by
Markup PMC.

• validate PMC XML

• preview the text generated from XML PMC

7.1.1 Before using the Markup

• you must have one article or text by file

• check if the file contents is same of printed version or PDF file

• check if the file format is HTML, .doc, .rtf

• check if the number which the articles belong is recorded in title and issue databases
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• If the markup will be done in a different machine than local server, copy the files bellow from (local server)binmarkup :

– ??_issue.mds - it is updated when a new issue data is input on or modified in the database

– issue.mds - it is updated when a new issue data is input on or modified in the database

– ??_attb.mds - it is updated when a new code table data is input on or modified in the database

– automata.mds - it is updated when a new title data is input on or modified in the database

– journal-standard.txt - it is updated when a new issue data is input on or modified in the database

7.1.2 Open the program

Go to the menu, select SciELO and Markup

The program will try to open the Microsoft Word Program which is set in the file bin\markup\start.mds.

If the path is not valid, the program will ask for the right path of Microsoft Word Program.

Other option is to change this path by editing the bin\markup\start.mds file.
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Just in case it doesn’t appear the message about macro execution, you need to drop the macro’s security level down.

In Word 2003, it appears as following:

If Word program opens correctly, the Markup bar will appear at the inferior part of the screen.

7.1. Markup 107



pcprograms Documentation, Release 4.0.050

In Word 2007, it is different. The Markup bar will appear inside the Supplement group.

Open an article or a text file.
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As clicking on Markup button, two options will be shown: configuration and Markup DTD-SciELO.

In Word 2007:

If the macro was not loaded normally, the message bellow will appear:
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To solve it, select the Tools->Supplements and Models option of the menu.

So, remove the incorrect item, and put on the right path file corresponding of c:\scielo\bin\markup\markup.prg.
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7.1.3 Using the program

Open a .html or .doc file.

Click on Markup DTD-SciELO to start the markup.

The Word bars will disappear, remaining only the Markup bars:

• white: files operations, edit or eraser a tag, automatic markup

• orange: floating tags, can be used in any document part

• green: tags that have a specific hierarchy of DTD
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In Word 2007, all these tags bars are agrouped in Supplements.

The markup starts when you click on document type button:

Article specifies scientific articles. They must have key-words, abstracts and bibliographic references. It is
accounted in bibliometric module as scientific production.

Text specifies texts that are part of a journal, but don’t have scientific worth. Ex.: Editorial, interview, review,
etc.

7.1.4 The bars
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General bar

Exit button

To exit the program, click on Exit button.

Choose one of the options bellow.

Element’s attribute edition button

To edit attributes of an element, select the name element, then click on the edit (pencil) button. The program will ask
for changing the values of the attributes.

Delete element button

To delete one element and its attributes, select the element name, then click on the delete button. The program will ask
to confirm this action.

7.1. Markup 113



pcprograms Documentation, Release 4.0.050

Save file button

To save a file, click on the save button.

Automata 1 button

To mark bibliographic references automatically:

• the journal have to have an Automata file (read how to programming an automata), which configures the rules
to identify the references elements.

• select one bibliographic reference until its final dot, including, and then click on the Automata 1 button.

This action will activate a tool which will try to identify the bibliographic reference elements automatically. The tool
will present the several possibilities of identification. So the user have to select the correct one.

Automata 2 Button

To mark a set of bibliographical references automatically (available only for Vancouver standard). Select one or more
bibliographic references and then click on the Automata 2 button.
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The program will mark all references it can identify and will also keep the original reference, marked as [text-ref].
Thus the user can compare them in order to check if the reference was correctly identified and proceed the correction,
if it is necessary.
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Validate markup button

To validate the markup, click on the Validate markup button. It will run the SGML Parser.

7.1.5 Floating tag bar

The floating elements are the ones which can appear in any part of the text.

aff identifies an author affiliation

ign identifies a text which can be ignored

tabwrap (only valid for XML PMC)

figgrps (only valid for XML PMC)

figgrp (only valid for XML PMC)

equation (only valid for XML PMC)

cltrial identifies clinical trials data

list (only valid for XML PMC)
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xref (only valid for XML PMC)

uri (only valid for XML PMC)

sciname (only valid for XML PMC)

7.1.6 Hierarchical tags bar

This bar groups the elements according to the DTD. This bar will present the elements of one hierarchical level each
time. As the user goes to a down or up level, the bar presents respectively, only the down or up level. The user goes to
a down level, when clicks on an element or on a down arrow, and goes to an up level, clicking on the up arrow.

If there is no element marked in the text, then the initial elements buttons (article and text) are presented.

If there are any element marked in the text, the level just below the article or text are presented.

Navegation

The down and up arrows are to navegate between hierachical elements levels. The user should find the elements to
mark in the bars.

Clicking on the down arrow next to bibcom, its children (hierarchical related) will appear.

Clicking on the up arrow, at the right side of the bar, the elements of the superior level will appear.

For example:

Down

Bar of front element

Bar of front element’s children

Bar of titlegrp element’s chidren
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Up

7.1.7 Error messages

To avoid errors and to guide the user during the markup, the program presents some messages in case the procedures
described previously have not been correctly done. For example:

• If the user has clicked on an element button and no text was selected.

• If a mandatory atribute value wasn’t filled in.

• If the user try to insert a tag in an incorrect place, disaccording to DTD.

Bad value to a mandatory attribute

The user tried to identify an element which is not according to the hierarchical structure / DTD
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the user has clicked on an element button and no text was selected

7.2 Markup PMC

Use the same Markup Program. So, read its documentation.

And use a copy of the markup file to generate the XML file to PMC.

The PMC Markup will be done on a copy of a markup file.

PMC Files Specifications: http://www.ncbi.nlm.nih.gov/pmc/pub/filespec/

7.2.1 The bars

General bar

Generate XML file button

To generate the XML files to PMC, the user must guarantee that xmlbody and other tags must exist, including the
regular markup.

Validate XML file button

Click on it, to validate the XML file.

If the XML file is invalid:
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If the XML file is valid:

Preview the text generated using the XML file button

To preview the text, generated from XML file, in order to check if how the fulltext will be presented in the website,
click on the Preview text button.
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7.2.2 Markup button

To go back to markup file.

7.2.3 Floating tag bar

The floating elements are the ones which can appear in any part of the text.

aff identifies an author affiliation

ign identifies a text which can be ignored

tabwrap identifies a table (includes label, caption and image) (only valid for XML PMC)

figgrps identifies a compound figure (Fig 1A, 1B, etc), and each one must be figgrp (only valid for XML PMC)

figgrp identifies a figure (includes label, caption and image) (only valid for XML PMC)

equation identifies an equation (represented by image or LaTex or mml:math) (only valid for XML PMC)

list identifies a list (only valid for XML PMC)

xref identifies cross reference (only valid for XML PMC)

uri identifies external links (only valid for XML PMC)

sciname identifies scientific names (only valid for XML PMC)
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7.3 SGML Parser

• single-user program built in Visual Basic and C, and uses sp120.dll library.

• It is always installed, because it is used in several situations: by the Markup, by the Converter (internally), and
stand-alone.

• tool to check whether the markup done using Markup is according to DTD SciELO.

This program can be run:

• or from Markup

• or by PC Programs’ menu

• or by Converter, internal use, to analyze and obtain the values of the elements and their attributes.

Parser called by Markup: the file, which is open in the Markup program, is open in SGML Parser program.
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Parser called by Menu: after opening SGML Parser program, the user have to open a file .txt or .sci, by accessing the
File menu option.
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This procedure must be done to *.sci files generated by Converter when some problem is identified in the marked files.
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7.3.1 Configuration

Access the Menu and select Configuration option.

The options Add ignore markup to document and Add SGML declaration to document must be selected, when the document is:
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• an article

– File Containing the DTD = C:\SCIELO\BIN\SGMLPARS\article4_0.dtd

– Document Type Name = article

• a text

– File Containing the DTD = C:\SCIELO\BIN\SGMLPARS\text4_0.dtd

– Document Type Name = text

7.3.2 Document analysis

After configuring, the user have to use Parse menu option in order to analyze the marked document.
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If everything is correct, the message bellow is presented:

So, the user can exit the program.

If there are errors, the Parser will indicate the line and the error type occured. In this case, the user must go back to
Markup program and make corrections and then repete the procedure of using SGML Parser, until there is no error.
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CHAPTER 8

Support

How to get support
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